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INTRODUCTION
Purpose
This guide will provide landowners like yourself information on how to conduct a basic inventory of
nontimber forest products on your land and digitally map your data. You can use free, widely available digital
mapping tools that are increasingly a part of everyday life. A glossary of key terms is provided at the end of
this guide. After learning some basic steps, you will be able to inventory and map features on your land, to
show scenarios for possible future management activities, and to visually monitor changes on your land over
time through the maps you create.

What are nontimber forest products?
Nontimber forest products (NTFPs) broadly include all non‐industrial vegetation in forests and agroforestry
environments that has, or potentially has, commercial value. The boreal, temperate, and subtropical forests
of the United States have both an extensive diversity and density of nontimber forest products. Some
commonly collected NTFPs in the U.S. are wild mushrooms, berries, ferns, tree boughs, cones, moss, maple
syrup, honey, and medicinal products such as cascara bark and ginseng. For a clearinghouse of publications,
photos, videos, links to other NTFP sites and other useful information visit www.ntfpinfo.us.

Why would I want to inventory and map my NTFPs?
An inventory of species locations and other features on your property, such as ponds, creeks, buildings and
tree stand types, provides invaluable information about the current and potential economic value of your
land. In northwestern Oregon, for example, even a small, 5‐acre forest can have hundreds of commercially
valuable species. A map can help you remember where species are. Many NTFPs are small, like
groundcovers, and some, like truffles, are underground. A map can make it more efficient to find them again
and can help you to avoid disturbing patches and habitat by other activities. A map of your species locations
can reveal growth patterns across the landscape. For example, a species may occur in several areas with the
same elevation or orientation and the map might suggest other areas on your land to check for additional
sources of product. A map can help you see changes over time each time you update the data. For example,
you might see how the building of a new road impacted a huckleberry patch or the color of the salal leaves.
No single species may prove abundant enough to be very valuable on its own, but an inventory and map can
show the economic potential of managing for and harvesting multiple low value products from your land over
time. An inventory and map maintained over time can also be valuable for transferring knowledge from one
generation to the next or for showing extra land value in real estate transactions.
You may wonder whether you can just look at a satellite map of your land online, for example on Google or
Bing Maps and tell what is on your land. While it is true that satellite imagery is getting more detailed in
most locations on the planet, there are many limitations to satellite data. For example, in forestlands the
tree canopy often hides understory species. So while you might be able to get a general idea of tree types
and habitat by looking at a satellite map, and even perhaps make out an NTFP species, it is unlikely you
would be able to describe important characteristics like quality, regeneration, and accessibility without
actually seeing the NTFPs in person.
You may also wonder, why not just make a map by hand? Hand maps of inventories can be useful.
However, it is hard and time consuming to accurately make a map by hand that includes the high level of
detail, the changes over time, and many other features that you can produce quite easily on a digital map. If
you do opt for hand mapping, you might start by acquiring an aerial photograph and tracing your boundaries
and features on paper to serve as a base map you can photocopy. Make sure to include a scale, legend, a
direction indicator, and the latitude and longitude coordinates of a control point on the land.
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PART 1. CONDUCTING A BASIC INVENTORY OF YOUR NTFP SPECIES
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Nontimber forest products include products obtained from forests for personal or
commercial use other than industrial timber. Example photos: (a) chanterelle mushroom,
(b) beargrass, (c) skunk cabbage roots, (d) dwarf Oregon grape, (e) artist’s conch, (f) devil’s
club, (g) Oregon white truffles, (h) wild iris, (i) Oregon grape root, (j) cascara bark, (k)
Western sword fern.
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Overview
Although you may feel the need to and have the resources to hire a forester or botanist to assist you with
inventorying your land, you will probably find that they don’t know much about commercial NTFPs, though
they could have other highly useful information such as knowledge about grants and marketing. Commercial
NTFP harvesters and buyers often have a great deal of knowledge about the species they work with, but
these groups may be hard to find or to interest in coming to your land to do an inventory. The good news is
that you don’t need a professional to get started: anybody can do basic inventories with a little preparation.
Then, in the future, should you want to hire a professional to do timber cruising and formal mapping you will
have NTFP data that they can include in their analyses of your land.

Step 1. Familiarize yourself with nontimber forest products
Begin to familiarize yourself with commonly marketed nontimber forest products (NTFPs) by
observing what is sold in markets, talking with businesses selling NTFPs, speaking with your local
forestry extension agent, and reading extension documents specifically written for commercial
harvesting (for example, on www. ntfpinfo.us/publications). Look at photos online and check out a
local plant field guide from your library. It won’t take long before you can recognize many NTFP
species. For those that you are unsure of, you can send photos to your extension agent or a botanist,
or go into a local native plant nursery and ask for help with identification.

Step 2. Make a list of potential products from your land
Make a list of the NTFP species you think might be on your land (or could be reintroduced) in a table
such as Table 1. Create extra blank rows that you can use to write in NTFPs you discover when you
are walking around. If you don’t know the common or scientific name of something you find but you
think it might have commercial value, take a picture and a sample that you can show to experts who
can positively identify them.

Step 3. Put together a field kit
Include a notebook, pencil, a digital camera, bags for collecting samples, labels to write on (such as
masking tape), and if available, a GPS receiver and/or mobile phone that can take waypoints.

Step 4. Choose a season and route
Ideally you want to document plants in their different life stages, so give some thought to how you
might walk your land in a pattern you can remember and repeat in other seasons and in future years.
Professional plant surveyors have many different methods they can draw from, depending on the
scope of the land and inventorying goals. For example, a surveyor might draw line transects at
regular intervals on a map, then, when in the field, count and measure the species within those
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Table 1. Sample inventory list of nontimber forest products found in Pacific Northwest
Nontimber Forest Products
(common name & scientific name)

Present?
(Y,N, Don't
know)

Number
or
Quantity

Size,
Volume,
or
Weight

Condition
(good, fair,
poor)

Age
(years)

Location
(waypoint)

Photo Name or
Number (s)

Wild Foods
Stinging nettle (Urtica diocia)
Huckleberry (Vaccinium spp.)
(write in more as you learn and see them…)
Herbal Medicines
Oregon grape root (Mahonia aquifolium)
Elder flower and berry (Sambucus nigra)
(write in more as you learn and see them…)
Decorative Materials
Manzanita branches (Arctostaphylos spp.)
Salal (Gaultheria shallon)
(write in more as you learn and see them…)
Landscaping & Restoration Transplants
Kinnikinnick (Arctostaphylos uva-ursi)
Sword fern (Polystichum munitum)
(write in more as you learn and see them…)

transects (or within eyesight of the transect, or in 1 x 1 meter plots at intervals along the transect,
etc.). Although inventorying (and monitoring your inventory places over time) that meets rigorous
scientific standards can be a complex activity typically requiring professional training, most
landowners without professional training can still get started doing simple inventories that are highly
useful for understanding what is on their land and informing management decisions. Start simple,
find a repeatable pattern you can walk on your land, and take good data (Steps 5 – 7). If you veer off
your transect to avoid a hole, hill or other obstacle that’s okay, especially if you can mark your trail
and the plants you identify with GPS waypoints as in Step 7. If you want to learn rigorous
inventorying techniques you might check for courses with your local extension office and look at
publications such as the 2012 extension guide, “Basic Forest Inventory Techniques for Family Forest
Owners” by Kevin Zobrist et al.

Step 5. Walk your land, observe and take notes
Document the number, size, condition, age, and location of each species. Rough estimates are fine.
Depending on the product and its use, factors such as accessibility, proximity to roads, pollutants,
and water sources may also be noteworthy. As your experience grows, you will begin to recognize
the various life stages of species, including the seed, seedling, mature form, flower, fruit, and
dormant state, all good data to include in the chart or make notes elsewhere about.
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Step 6. Take Photos
Take multiple photos of each species from 1, 10 and 40 feet away. Note the date and time of each
picture as you take it, so you can accurately match plants and their locations when you process the
pictures later. If you are in the market to buy a new digital camera, you might consider the type that
has a built‐in GPS receiver that automatically marks the location of each picture with a waypoint.

Step 7. Note the location of each species
Digital Waypoints
The easiest way to know the exact location of a species is to take a digital waypoint (see the glossary
for an explanation of digital waypoints and devices that can create them). It’s not essential to be
able to take a digital waypoint when inventorying, but not having digital waypoints will make creating
an accurate map of your inventory more difficult, especially on tracts of land larger than five acres.
Unless you invest in or have access to a high‐end GPS device, the accuracy of your waypoints taken
by common everyday GPS devices (e.g., smart phones such as the Apple iPhone, designated GPS
equipment like the Garmin Oregon) such as smart phones will probably be somewhere between 10
to 25 feet, but that is okay for the kind of basic plant inventory described in this guide. For example,
you may not be able to walk back to the exact hole where you dug a truffle from under the ground
and marked with a digital waypoint, but you can at least get back to the general area and be able to
see on your land map habitat where truffles are occurring.
Take a digital waypoint of each species you include in your chart and for each area. If the species is
spread out over a distance take multiple waypoints that you can use later for creating a polygon in a
mapping program to show the entire area covered. When taking waypoints you have two options for
recording the information. Your GPS receiver will store each waypoint and most devices allow you to
rename the waypoint as you take them to help you keep them distinguishable from one another.
Stored waypoints will be imported into the GIS software for making the map later. Your second
option is to write down in your notes the waypoint latitude and longitude (and altitude if included
and needed) as you take it and enter it manually in the software later. Although taking notes while in
the field entails a little more writing, and entering the waypoints manually increases the chances of
accidental errors, it has the advantage that you can include the waypoints in your chart and notes as
you take them.
Manual Locating
If you don’t have the ability to take a digital waypoint, then get an aerial photograph or map of your
land from your county government, a university library, or print one from Google Earth. Identify a
control point (for example, a survey marker, a hilltop, an old tall tree, a known point in a road) that
you positively know the location of and measure from it either by estimating distance or by using a
reel‐style tape measure. Use a compass so you know where north is. Use a code such as 001, 002, to
keep each measurement distinguishable in your notes and on your map or aerial photograph. Your
note might look something like “001 ‐ Cascara 100 feet south of fire hydrant.”
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PART 2. MAKING A DIGITAL MAP FROM YOUR NTFP INVENTORY DATA
This exercise will take approximately 2 to 4 hours to complete depending on your computer
skills.
If you have access to a computer and some basic operational skills such as installing and opening a program
and using a mouse, touchpad, or touchscreen, you can do basic digital mapping that will help you know what
is on your land and where without a lot of time and effort.
The GIS software we are using is Google Earth because it is free, powerful, one of the easier programs to use,
and it works on both Windows and Mac computer operating systems. Google Earth already has satellite
imagery of all land around the world, though at varying degrees of resolution. Google Earth is constantly
refining maps, so if your detail isn’t sufficient now, it likely will be in the near future. You can also import
maps that you might find at your county government or regional university. Google Earth has some smart
phone and tablet apps, though they have more limitations than the more powerful desktop version. Our
instructions are for Google Earth on a desktop computer.
When you make a map in Google Earth, it is on your computer and can only be seen by others if you
intentionally share it with them through e‐mail, uploading to the Internet, or other method. The satellite
data that Google uses is publically available, but because Google modifies the imagery, they are able to
copyright it. If you want to use maps generated through Google Earth commercially, they require a license.
Google just makes it easy to access them through their program. Details about free use and licensing are
available in the Google Earth help menu.
The following instructions assume you are working on your own desktop computer. If you do not own a
computer, many public libraries have Google Earth installed and many college and university libraries have
the more powerful paid version Google Earth Pro installed and may provide access to community members.
If you are not on your own computer then Step 1 will not apply and other steps may or may not depending on
the restrictions set by the owner. If working on a public computer, work from a USB thumb drive that you
can plug into the computer to save your work (go to the File menu in the program and select Save Place As).
Remove the USB drive when you are done working, leaving no data on the public computer.

Step 1. Download Google Earth to your computer
If you do not have Google Earth already, go the website www.google.com/earth/, click on Download Google
Earth, and save it to your computer. If your computer already has Google Earth, make sure you have the
latest version by opening it, going to the Help menu, then selecting Check for Updates. The exercise in this
guide is based on version 7.

Step 2. Install Google Earth on your computer
Open the GoogleEarthSetup.exe file and install the program. This will actually open an installer that
will download the remainder of the program. If your Internet connection is slow the download may
take a while, so be patient.
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Step 3. Start Google Earth
After the installation completes, start Google Earth. You may see a start‐up tips window. Close this.
The Google Earth desktop is divided into several frames: Places, Layers, and the map frame. At the
top of the desktop are two menus, the drop‐down menu bar and an icon menu of shortcuts.

Step 4. Expanding and contracting “My Places” folders
On the left you will see a column with Search, Places and Layers. In the Places frame you may see
subtitles such as Sightseeing Tour, The Eiffel Tower, and other pre‐created Google Earth files. If you
click on the 2nd small black triangle (see red arrow in image below) you can close these Google Earth
preset places. Try clicking both arrows a few times to see how they work.

Step 5. Adding a new folder.
Right click on My Places and select Add from the menu across the top of the screen, then Folder. A
window will pop up. Rename Untitled Folder to Smith Forest Unit 1. As your project grows you will
probably add many folders and subfolders to organize and represent your data. It will be easier to
keep data separate in Google Earth and have manageable map sizes for viewing and printing if you
keep land parcels separate, or break large units into smaller sections. For example, for a second
parcel you might create another folder called Smith Forest Unit 2. Toward the end of this exercise
you will learn about features like latitude and longitude grid lines that can help you disaggregate and
demarcate land units. The window should look like the following:
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Now click OK. This will create the new folder under Smith Forest Unit 1. If you made a spelling
mistake or want to rename a folder you can easily do so by right clicking on the name and selecting
Rename.

Step 6. Setting some viewing options
From the menu at the top of the desktop select View. This will open up a drop‐down window where
you can set some viewing options. To place a check mark, click to the left of the label. Check marks
should be next to the following options as shown below:
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Now look to the Layers frame at the lower left. Click on the Roads checkbox. Your layers frame
should look like the following screen print:

Step 7. Searching for a location
In this mapping exercise, we use Mt. Pisgah in Oregon as our geographic example to practice
mapping. Mt. Pisgah is a real place; it serves as a good example because the map has good
resolution, open and closed canopy, roads, paths, buildings, a river, a pond, and varying elevation.
Some of the species inventory and locations we have you create in the exercise are fictional.
In the “Search” frame type 34901 Frank Parrish Rd. Eugene, OR 97405 then hit Search.

The desktop map in the right frame should zoom to your location. There should be a red Google
Earth Placemark icon (or possibly another style icon if you are using different version of Google
Earth) in the center of the map. We are going to clear it off the map.
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Step 8. Clearing the search results place mark.
To clear the search results place mark, click the X in the bottom right corner of the Search frame. The
address should disappear from the Search field and the placemark icon from the map.

Step 9. Add a custom Placemark to the map
We are going to add our own custom placemark. Click on the yellow pushpin icon at the top of the
screen (or go to Add on the drop‐down menu and select Placemark).

The New Placemark window will open. In the Name field type Old Barn.
With the New Placemark window still open click on the yellow pushpin icon next to the name field.
This will bring up another window where you can change the icon.
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Select the icon that looks like the outline of a house:

Then go to the top of the icon window and type .08 in the Scale field and 65% in the Opacity field.
When you are adding place marks you can change the icon, color, scale and opacity of each icon. You
can even add custom icons. This editing ability will prove very helpful as you map: you can fade less
important objects and call out important ones with bright colors or representative icons.

Now select OK to close the icon window. This will bring you back to the New Placemark window.
Notice that midway in the window there is a tab called Description with a blank field below it. You
could use this place to add in information about your placemark, but we do not recommend it for
inventorying. If you do use it, the first two lines of your description will show in your Places folders
and files. In inventorying, you could eventually have hundreds of species listed in the Places frame
and the tidier you can keep them, the easier it will be to navigate through them when there are a lot
of things listed there.
Notice next to the Description tab there is another called Style, Color. Here is where you can adjust
the color, scale, and opacity of the label that appears next to the icon we are editing. For now we
will leave it alone (later you will learn how to get back and adjust existing icons and text).
With the New Placemark window open you will notice on the map the house icon with a blinking
yellow box around it and a text label Old Barn. Hover your mouse pointer over the icon and left click.
This will allow you to drag the icon around. Move it so that it is on top of the structure just below it
on the map as shown in these two graphics:
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 Before
After 

Now select the OK button to finish the process and close the window.
In the Places frame to the left you should see the new Old Barn placemark under the Smith Forest
Unit 1 folder. If the Old Barn placemark is not underneath the Smith Forest Unit 1 folder you can left
click it wherever it is, keep the left mouse button held down, and then drag it to the Smith Forest
Unit 1 folder. Its structure should look like the screen print when you are done:

Step 10. Create a folder structure
Now create a new folder under Smith Forest Unit 1 called Structures. To do so, right click on the
Smith Forest Unit 1 folder and select Add, then Folder, then type in Structures for the name and
select OK. Then select the Old Barn placemark again by left clicking on it, holding the mouse button,
then dragging it to the Structures folder. Now right click on Smith Forest Unit 1 again and add a
folder named NTFP Inventory. Under NTFP Inventory create two folders, one called Medicinal and
another called Restoration. Your folder structure in the Places frame should look like the following
when you are done with Step 10:
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Step 11. Delete the Sightseeing Tour (optional)
Google Earth has a pre‐created tour in the “My Places” frame. You might want to click on this and
give it a try. If you want you can point your mouse on it, right click, and delete it. The screenshots in
the remainder of this exercise show it as deleted. If you take the tour and your screen doesn’t
correspond with the screen shots in this exercise you might need to reset the screen by pointing your
mouse in the middle of the map and pressing the “u” key on your keyboard.

Step 12. Move all your project folders into a new top‐level folder
Now we are going to show you how you can move the entire Smith Forest Unit 1 folder and all its
subfolders into a new folder. Move your mouse pointer over My Places, right click and Add a new
folder called Smith Forest Lands. Now move your mouse pointer over Smith Forest Unit 1 and left
click, hold the button down, and then drag the folder into the new Smith Forest Lands folder. Notice
all the subfolders and Placemarks move with it. Your new folder structure should look like this:

Being able to redo your folder structure and move files around is an important feature that makes it
easy to reorganize your data to help keep it clear and manageable to work with.

16

Step 13. Understanding the map information.
Notice on the map there are various useful pieces of information.
1) In the bottom left corner you will see the map Scale in feet (the default setting). You can change
the units of measurement to metric in the Options window under tools on the menu bar at the
top of the program.

2) In the bottom left corner you will find Imagery Date, the date of the satellite image was taken. To
the right of it are Longitude and Latitude, which adjust to wherever you position your mouse
pointer on the map, “elev,” referring to the elevation of the land (it also adjusts with the mouse
pointer) and “eye alt”, which is the altitude that you are looking down at the ground from.

3) In the top right of your screen if you look closely you will see the program’s Navigation tools. If
you hover your mouse over the area it will become opaque. Click on the various arrows and you
will see that you can turn the map, move it up and down, and zoom in and out. You can also
zoom in and out using a scroll wheel if your mouse has one. Also note that if you zoom in to the
ground then right click and hold your mouse button when you move the pointer it will give the
impression of tilting to give a view more parallel to the ground. If you tilt the image and then
want to reset it back to the default view type “u” on your keyboard. You can also find a reset
option under View, Reset on the menu bar at the top of the screen.

Step 14. Using the Navigation tools
At this point in the exercise we recommend practicing the navigation tools that Google Earth
provides to get comfortable with how they work. We also recommend visiting the Google Earth
video tutorials website (www.google.com/earth/learn/beginner.html). It’s not important to fully
understand how everything works at this point. Just get a general feeling for how things work and
what you can do with Google Earth. After you have had a chance to work with the program it will
make more sense.
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Step 15. Saving your project.
In Google Earth you can decide which files to save by selecting the check boxes next to the files in
the Places frame. For example, in our project you could save just the medicinal inventory data by
unchecking all the boxes except Medicinal. This is useful when you want to share parts of your data
with another user. For this exercise we want to make sure to save our entire project. Point your
mouse to Smith Forest Lands and then right click the mouse. In the pop up mouse menu select Save
Place As. A window will open where you can choose the location to save your project files, the file
name, and the file type. If you don’t already have a filing system, save the file to a new folder on the
desktop. In the file name field you should see Smith Forest Lands.kmz. Where it says “Save as Type”
select the small arrow on the right to open a drop‐down menu and then select Kml. Notice this will
change the file name to Smith Forest Lands.kml. Either file type is okay but Google Earth
recommends using kml when projects are small. KMZ is for compressing (reducing in size) very large
files to make them easier to share with others.

Now select Save. Get in the habit of saving your work periodically, especially after any significant
work. Google Earth does not autosave and it sometimes crashes because it is working with large
graphics. It’s also a good idea to save the same file in more than one place so you have a backup
copy in case the original file becomes corrupted. You can also use different file name versions with
a date such as Smith Forest Lands 10‐14‐2010, Smith Forest Lands 10‐16‐2010, etc.
If you are working on your own computer it is best to reopen your files by opening the Google Earth
program rather than opening the .kml or .kmz files. If you do restore your files by opening the .kml
or .kmz files you will see they open up in the Temporary Places folder that you will need to save
before exiting the program (the program should prompt you before exiting). You can read more
about saving at the Google Earth help site online.

Step 16. Resetting the Map to the base position
Point your mouse to Smith Forest Unit 1 under Places and double click. This will reset the map to
the unit we are working on in Smith Forest Lands in case the map has moved around during the
folder creation and saving exercises. Now point your mouse on the center of the map, click the left
mouse button and release, then type the “u” on your keyboard. This will remove any tilting that
might also have occurred.
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Step 17. Creating a waypoint.
Now we are ready to practice creating a waypoint (see glossary). There are many ways to acquire
the data to add waypoints to your map. We will look at two common options: Using a .gpx file
created by a GPS Receiver and manually adding latitude and longitude coordinates.
Option 1. Use a .gpx file created by a GPS Receiver.
GPX stands for GPX Exchange Format, it is an open‐source digital file format used in GPS receivers
that stores location, elevation, and time and that can be exported to your computer to be used in
GIS software like Google Earth. For this example, the waypoint readings were taken on an Apple
iPhone using a free app (a small program that runs on a smartphone) called GPS Memo. Every GPS
Receiver device software or smart phone app takes and exports waypoints (and other data such as
trails) in a different way, so you will need to read the instructions for whatever device you have.
Although the interface will be unique to the software or app, here is a screenshot of how four
waypoints we took at Mt. Pisgah look on our iPhone app GPS Memo.

We replaced the default waypoint numbering in the app with our titles to make it easier to
recognize them. On smartphones it is especially fast and easy to change titles, compared to many of
the more rugged dedicated GPS Receivers (for example, Garmin Oregon) that have screens that are
more difficult to type on, but that are completely weatherproof. If you plan to use your smart
phone in the rain you can often find waterproof aftermarket cases like the Otterbox for the iPhone.
If your GPS Receiver is a smartphone app like the one we are using in this exercise you can e‐mail
the data to yourself from the phone. Smartphone apps also usually provide a way to transfer data
to your computer through a USB cable or data can be uploaded to a website. Dedicated GPS
Receivers may have e‐mail transfer capability but most require you to connect to your computer
using a USB or other type of cable and then download the data. Here is a screenshot of the e‐mail
we received from our GPS Memo smartphone app:
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We then saved the .gpx e‐mail file attachment to a mapping folder on our computer where we keep
our GPS data, Google Earth files and other files associated with mapping our land units.
When you have the ability to take waypoints and save them as .gpx files you can try importing the
file to Google Earth. For now here is how you do it. Go to Google Earth, select Tools on the top
menu, then select GPS from the drop‐down menu. Your settings should match the following:

After you get more experienced with Google Earth, you can try taking tracks and routes with your
GPS Receiver and then importing them into Google Earth. For now we will just work with
waypoints.
Select Import and the waypoints in your file will appear under the Temporary Places folder in the
Places frame, and also on your map.
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Remember, at some point you will likely have many folders and files in Places, so initially having
them in the “Temporary Places” folder will make them easy to find. Make folders for the new
waypoints or sort them into existing ones. You can right click on each one to rename them if you
need to. If you had a .gpx file you were practicing an import with, delete those imported files before
continuing on with this exercise. Your Places folder structure should look like this again:

Option 2. Manually add latitude and longitude coordinates to your map.
Another way to get waypoint data onto your Google Earth map is to manually insert latitude and
longitude information. Two examples of how to get this data:
a) If you have a GPS Receiver that is picking up a signal where you are, it has a screen that allows
you to view latitude and longitude. So when you are doing your inventory, rather than collecting
a waypoint that you will have to export from your device to Google Earth on your computer, you
can write the data down in your notes. The risk of this method is that there is a greater
possibility of an entry error with writing.
To manually add the waypoint on your Google Earth map click on the Add Placemark image. A
window called New Placemark will open and will probably already have Latitude and Longitude
coordinates listed for where the new icon (usually a blinking box around a push pin) is located.
Give the placemark a name a representative icon (see Step 9), then type in your latitude and
longitude data from your GPS Receiver Waypoint and select OK. The placemark will appear on
the map (the elevation is automatically shown based on the location on the map). For this
exercise enter:
New Placemark Name

Latitude

Longitude

Manual Lat Long Test

44° 0'21.88"N

122°58'47.75"W
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Select OK and you will see the new placemark added with the latitude and longitude coordinates
you typed in. Now find that new file in the Places frame to the left and delete it. You will see
that it disappears from the map.
b) Another approach to manually adding latitude and longitude is to visually estimate where a
placemark should go by looking at the Google Earth map. This is possible only if your map gives
you good close‐up resolution/detail when zoomed in and you are confident of locations or only
need a general proximity. If your GPS Receiver has a good signal, waypoints will be more
accurate but this method is simpler and faster. To add a placemark using this approach zoom in
on our map as far as you can while still seeing the ground relatively clearly. You can probably
get as close as 125 feet but that will depend on the quality of your monitor.
Point your mouse to the Restoration folder in the Places frame to the left. Add a new placemark
called Acorns approximately 25 feet from where you would estimate the southeast corner of the
Old Barn building is and type Acorns. Change the scale of the icon and the text to .8 and leave
the color as white (if your color isn’t white you can point your mouse at the file in the Places
frame, right click, and select Properties and that will bring a window up where you can edit the
file). Select OK to add your placemark to the map and to the Places frame. If your new Acorns
file isn’t under the Restoration folder you can move it by left clicking your mouse on the file and
then dragging it to Restoration (this just sorts the file in Places and does not move where it is
located on the map). Your folder structure and your map graphic should look like this:

When you start mapping your inventory of your land, you may prefer to use the scientific name of
the product instead of the common name as your Placemark label. There is no right or wrong way to
do this; it’s really personal preference. In Step 17 we suggest adding a code in front of your text
label. If your map gets too cluttered with the text of Placemark labels you could edit your names
down to the number code to reduce the label size.

Step 18. Add a code to your species placemarks for use in a spreadsheet
As mentioned earlier in this guide, we don’t like to use the Description space in the New Placemarks
window because it causes the folders and files in the Places frame to take up more space, making it
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harder to navigate. After you get practiced at Google Earth, you may decide you prefer to use that
space. For this exercise we will demonstrate using a code prefix with your species placemarks that
corresponds to a spreadsheet.
A spreadsheet will allow you to organize and sort detailed descriptive characteristics about your
species such as scientific name, other common names used, quality, and abundance. To move data
between spreadsheet cells and Google Earth use copy and paste. There are many different
spreadsheet programs, from free programs like OpenOffice.org Spreadsheet and Google
Spreadsheets to paid programs like Microsoft Excel and Apple iWork Numbers. Wikipedia lists
dozens, many that are online and free. All share the basic ability to organize data (numbers and
text) in a table of rows and columns that can be sorted alphabetically or chronologically and, for
numerical data, to perform various mathematical calculations. If you are not familiar with using a
spreadsheet, all of the programs listed above have guides and tutorials in their Help menus. You can
also create a table in a word processing program and transfer your data to a spreadsheet at a later
time if you need the more advanced features.
Right click on the Acorns placemark in the Restoration folder in the Places frame. Select Properties,
then in the name field type the number 1.1 in front of Acorns, and then click OK. This will rename
your placemark 1.1 Acorns.

Each additional waypoint for the species can be 1.2, 1.3, etc.
Your corresponding spreadsheet might look something like this:
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Step 19. Make a polygon (see glossary)
For our polygon‐making step we have five latitude and longitude waypoints we took around the
boundary of a fern patch. They are:
Waypoint Name
2.1 Fern
2.2 Fern
2.3 Fern
2.4 Fern
2.5 Fern

Latitude
44° 0'19.62"N
44° 0'20.49"N
44° 0'21.26"N
44° 0'21.02"N
44° 0'20.36"N

Longitude
122°58'40.38"W
122°58'40.23"W
122°58'40.53"W
122°58'39.73"W
122°58'39.66"W

Create a folder under the Restoration folder in the Places frame. Your folder and file structure
should look like this:

Now enter each set of latitude and longitude coordinates manually using the Add Placemark tool.
As you learned in Step 9, you can move the box around manually, but once you enter the data and
select OK, the placemark will position itself to whatever latitude and longitude you entered. In the
Name field type 2.1 Fern and choose the white circle icon and reduce it to .8. Now copy and paste
the latitude and longitude readings for 2.1 Fern from the table above into the Latitude and
Longitude fields. You can also type the readings in, but follow the format exactly. If you are typing,
you can find a degree symbol in the Windows (version 7) Character Map located in your
“Accessories” folder on the “Start” menu.
Click OK and you should see the 2.1 Fern waypoint on your map with the white circle.
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Now repeat the process for the remaining fern waypoints listed on the table. When you are done
the waypoints should appear on your map at 325 feet from the ground like this:

Your folder and file structure in the “Places” frame should look like:

Now zoom your map in so you are looking at your fern patch boundary waypoints from
approximately 1,000 feet above ground (shown by Eye Alt, bottom right screen corner). Your eye alt,
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minus your elevation equals the viewing distance above the ground. Depending on the resolution of
your monitor and the satellite imagery Google Earth is using for the area of your map you might
need to use a higher altitude or zoom in more closely, perhaps to 125 feet.
Click the Add Polygon icon on the icon menu. In the Name window type “Fern Patch 1.” If the Add
Polygon window is blocking the view of your fern waypoints on the map, point your mouse to the
title area at the top of the window, left click and move the window somewhere else on your screen.
Now click the Style, Color tab. Click on the box next to Color under Lines, choose orange, and click
OK. Leave Width at 1.0 but change Opacity to 40%. Now do the same thing for Area. In the drop‐
down box you have the option of Filled, Outlined, or Filled+Outlined. Select Filled.

With the New Polygon window still open move your mouse pointer so that the 2.1 Fern white circle
waypoint icon is centered in the box like this:

Click your left mouse button once and let go; don’t hold the mouse button down. If you look closely
you may be able to see a blue square in the middle of the white circle, but if your monitor doesn’t
have good screen resolution you may not. If not, you should be able to continue anyway. Now
move the mouse pointer over the 2.5 Fern white circle and click the left mouse button and let go.
Now go to 2.4 Fern and do the same thing, then 2.3 Fern, then 2.2 Fern. Then click OK. As you were
clicking waypoints around the boundary of your patch you probably saw the polygon orange shading
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start to appear. If you make a mistake during this process, you can back up by hitting the delete
button on your keyboard, or click Cancel in the New Polygon window and start over. After you finish
you should see this:

In your “Places” folder structure you should see Fern Patch 1.

If it is not in the right folder, just left click on it and move it to the Ferns folder. If your Fern
waypoints aren’t in numerical order you can left click on a file and move it into the right order. You
can also right click on the Ferns folder and select Sort A‐Z.
Now right click on Fern Patch 1 in your Places folder and select Properties. Click on the Style, Color
tab and in the drop‐down list under Area change Filled to Outlined. Notice that your polygon is now
just an orange outline without the fill. You might also try adjusting the opacity, width, and colors to
practice how they work. Being able to make these adjustments will be very useful when you have
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many waypoints and polygons on your map. After you are finished practicing set the Lines and Area
colors, width and opacity back to where we had them.
In the Places frame uncheck the Fern waypoints and leave Fern Patch 1 box checked. This will make
the waypoints on the map disappear; try toggling them on and off to see how this works. Now
toggle Fern Patch 1 off also. Your Places folder structure under Ferns should look like this:

Step 20. Make an overlapping polygon
Manually enter these waypoints using Add Placemark like you did in Step 18. Put them in the
Medicinal folder in Places.

Waypoint Name
3.1 Oregon Grape
3.2 Oregon Grape
3.3 Oregon Grape
3.4 Oregon Grape

Latitude
44° 0'20.15"N
44° 0'20.44"N
44° 0'20.34"N
44° 0'20.19"N

Longitude
122°58'39.53"W
122°58'39.35"W
122°58'40.40"W
122°58'40.57"W

Now make a polygon from those waypoints called Oregon Grape Patch 1. Use the color purple for
lines and shades. The map polygon and folder structure should look like this:

If your polygon didn’t come out like this picture you can delete the file in the Places frame and try
again. You can start from any corner, just work clockwise or counterclockwise from point to point.
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Once you have your polygon uncheck the Oregon Grape waypoints in the Places frame and toggle
Fern Patch 1 and Oregon Grape Patch 1 on and off. Notice how they overlap when both are
checked.

Step 21. Create a potential trail route to your fern and Oregon grape patches.
When you are mapping, sometimes it is best to start with a waypoint on the ground, for example
when you want to map the specific location of a plant. Other times it will be helpful to start out
with an aerial view. For example, from an aerial perspective you might see obstacles not easily seen
from the ground, or ways to connect roads and trails may be more visible from above than from the
ground. To illustrate this we will create a trail from existing trails to your fern and Oregon grape
patches.
In your Places frame create a new folder under Smith Forest Unit 1 named Management. Right click
on the Smith Forest Unit 1 folder and click Sort A‐Z. Zoom to 1,500 foot perspective on your map
(shown in eye alt in the bottom right corner of your screen). Point your mouse to the middle and
click “u” on your keyboard to reset any tilt. Click on the Add Path icon in the icon menu at the top of
the screen. Name your path Possible New Trail 1. Then click Style, Color and choose the bright
green‐yellow color and set the Lines width to 8.0. Look at the graphic below to see our trail, then
point your mouse toward the little loop of trails to the southeast of your fern and Oregon grape
patch and drag the mouse to where your patches intersect. Don’t worry about being exact: the
purpose is to just give you a feel for how to draw a trail. Click OK. Your map and folder and file
structure should look like this:

29

Step 22. Measure distances
Right click on the Possible New Trail file and select properties and then click the Measurements tab.
Click on the drop down menu and select Feet. This will show you the length of your trail in feet.
Your trail will probably show a slightly different distance than our screenshot below because the
starting and ending points were estimated:

Now zoom out to about 2,000 feet as indicated by eye alt in the bottom right corner of your screen.
On the Tools menu at the top of your screen select Ruler. Click on the drop‐down menu and change
the Map Length unit of measurement to Feet if it isn’t already. Right click on the Old Barn
placemark on your map, then right click in the middle of the river directly west of the Old Barn. The
Map Length should be about 493 feet and the Ground Length should be about 495 feet. Ground
Length factors in the lay of the land so it increases if there is uneven ground such as hills and valleys.
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Now click on the Path tab in the Ruler window. Left click on the Old Barn, then on somewhere just
northwest of it, then in the middle of the river again. This is a way you can measure the distance of
multiple points.

Step 23. Print your map
Zoom to around 2,500 feet or until you have a perspective you would like to print. Move the map
around if needed. Under the main File menu click Print. Select Screenshot of the current 3D view.

On your printer you may need to change settings like landscape and color. Try a test print. If you
want to print a large version of your map you can save your file and take it to a printer with a
plotter. A 4’ x 4’ color map will probably cost around $30 to $60 depending on the quality of the
paper and ink you request.

Step 24. E‐mail your map
If you have an e‐mail client on your computer like Eudora, Outlook or Thunderbird, you should be
able to go to the File” menu, select Email, a small window will open to the right, then select Email
View. An attachment will automatically be generated and attached to an outgoing e‐mail. Just
complete the e‐mail information and send it. You can also e‐mail through a Gmail account if you
have one. You may first need to go to the “Tools” menu, select “Options,” then under the “General”
tab select “Use my Gmail Account.”
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CONCLUSION
Some Final Thoughts...
This exercise is intended to open the door to the possibility of using Google Earth to do simple inventories to
aid in building commercial nontimber forest product enterprises. Google Earth is a widely used program and
you will find many resources in libraries, the Internet, community colleges, extension programs and more to
help you increase your skills
Your forests probably have dozens of nontimber forest product species, and if your land is located in a place
like northwestern Oregon, even small acreages can have hundreds. One reason for doing an NTFP inventory
is to be able to see which species are abundant enough to sustainably harvest. Mapping is a great way to
illustrate the location and other data about your species. Mapping is also useful for identifying habitat that
could be restored to improve NTFP productivity, and to identify habitat and species that would benefit
ecologically from harvesting. The more thorough your inventory and mapping of species locations through
waypoints and polygons, the greater your ability will be to make informed management decisions. Mapping
can also be very useful for potential future management activities such as conservation easements, road
obliteration, and trail creation.
Be sure to check out Google Earth’s online tutorials. Also, many colleges, extension offices, and nonprofits
have created guides for various Google Earth applications. We’ve tried to make this guide as basic as possible
as an introduction for beginners. Explore these other resources to supplement this guide and to learn about
the many different ways you can use Google Earth.
Don’t forget to save your work often and have fun making maps with Google Earth!
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GLOSSARY
The following is a short list of common terms and concepts in computerized mapping. Not all terms are
included in our guide, but we include some of the key terms you will come across as you research and read
about mapping. When using our guide, don’t worry if you don’t fully understand each concept: following the
steps will get you started making a map. The terms and concepts will make more sense as you practice
making maps.


GPS. GPS stands for Global Positioning System. This is the U.S. satellite system that provides location and
time information anywhere on earth where there is an unobstructed line of sight to four or more GPS
satellites. It is readily accessible, free of charge to anyone with a GPS receiver.



GPS Receiver. A GPS receiver receives and triangulates signals from GPS satellites to calculate the position
of the receiver. If you have a navigation system in your vehicle, it is a GPS receiver. Garmin, Trimble,
Magellan, TomTom and GlobalSat are examples. Mobile phones (especially smartphones) can have GPS
receivers in them as well though they usually aren’t as powerful as a piece of equipment, like a Garmin,
dedicated to GPS. As phone technology improves phones may become the preferred way to take
waypoints because of the convenience and cost savings from using equipment you regularly carry around
with you. This will be especially true as they improve their ability to take waypoints in remote rural areas.



Waypoint. A waypoint is a digital record of a geographic location, or set of coordinates, showing
longitude, latitude, and sometimes altitude. Digital waypoints can be created by a GPS receiver.
Different companies, government agencies, and universities have created many different types of
waypoint formats. So if you are asked to make a format choice when initially setting up your GPS
receiver, choose a common one like GPX or NMEA to begin with.



GIS, GIS Data and GIS Software. GIS stands for Geographical Information System. It is a computerized
system for integrating, storing, editing, analyzing, sharing, and displaying geographic information (for
example., the shape and location of a pond on your land), usually as a map, and to aid in decision making
(for example, where to build a road). GIS data is the information you import into GIS software to make
maps. Waypoints, pre‐existing maps, drawings, and aerial maps are all examples of GIS data. GIS
software consists of computer programs such as Google Earth, MapWindow, and ArcView that are
installed on your computer, or that you use through an Internet web browser (Firefox, Internet
Explorer). At a minimum they allow you to view maps, but more powerful programs like MapWindow
allow you to use GIS data to produce custom maps.



Vector and Raster Data. When looking for GIS data to use in your GIS software you may see references
to vector and raster data (aka bitmap). These are the two main types of data formats that GIS software
utilizes. If you take a digital picture with your camera that is raster data, a grid of tiny pixels that when
combined make up an image. When you draw a picture in a program like OpenOffice Draw you save it as
a vector graphic. In general raster data is used to show lifelike images and vector graphics are used for
drawing and abstract art, though sometimes it is impossible to tell just by looking at an image if it is a
raster or vector image. If this is confusing don’t worry too much about, you may find you really don’t
need to know the difference when it comes to making simple maps.



Shapefile. A shapefile is a file containing vector data in one of three shapes: points, lines, or polygons.
These shapes are known as geometries in the GIS world. A point is a single point, a line connects two
points, and a polygon is any type of bounded object with an area inside it (for example: a circle, a
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rectangle, a pond, a mushroom patch, a country). To make a bounded object with an area inside it you
must have at least three connected points. If your property was in the form of a square and you took a
waypoint at each corner and then connected them in a GIS software program you'd see a square polygon
in the shape of your property. If your property curves along a river or other feature, by taking many
waypoints at close intervals along the curve when you map those waypoints in your software the polygon
would show a curve. To show the shape of a pond on your land you would walk around it and take
waypoints; the closer together the waypoints are, the more accurate your map of the pond will be. You
can make a map of a lot of things with points, lines and polygons!


Base Maps. A base map is any sort of pre‐created map of a geographic area. A base map can be as
simple as a line drawing of a state, an aerial photo of your land, or a detailed map showing topographic
features such as rivers, streets, elevations and more.



Layers. A layer is a collection of data about a particular kind of feature. Mapping software gives you the
ability to put layers of information on top of one another. Imagine you have an aerial photo of your land,
so the perspective you are looking down at it from is up in the sky. In GIS software photos are sometimes
used as base maps. Then imagine that on top of that aerial photo you lay a transparent sheet of plastic
on which you’ve drawn the roads that go through that land. Then you add a second transparent piece of
plastic that has all streams and ponds on the land, and a third that shows all the buildings. Looking
through the stack, you see your property with all those features in place. GIS software allows you to stack
up many layers and toggle views on and off to highlight different features.

